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LOGGING IN AND THE WELCOME PAGE 

Logging In 
 
1. Go to http://join.fusionuc.net and use the login name and password assigned to you to sign into your meeting site. 

Meeting participants do not need to sign in. 
 

 
 
 

2. Click “Submit”. 
 

 
 
 
The Welcome Pane on the Home Page contains several vital shortcuts which will help you get started right away. 
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Your Meeting Room: 
 
This section contains the meeting room that is typically used the most. In most cases, it will be user's default room. 
Underneath, you will note the large Join shortcut button, along with an invite shortcut, and the information for the room 
highlighted. Next to the Join button there is a Participant Join Link, along with a Copy hyperlink, which will allow you to 
copy the session's generic join link and send it via instant messenger, email, or the like. 
 

 
 
The Welcome Pane, located in the upper right-hand corner contains four shortcut icons. 
 
1. The Edit Icon serves as a shortcut to editing the room that displays in this pane. 

 
2. Manage Content allows you to upload content to the session.  

 
3. Report Session Attendance is a shortcut to this popular report, and 

 
4. Room Selection allows you to select a different room or create a new one without having to 

navigate to the My Sessions or Manage Sessions page. 
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Your Picture 
 

 
 
1. Click on the Update Your Picture Icon to expand the dialog box. 

 
2. Press Browse and navigate to the appropriate file. 

 
3. Click Update to upload a picture for use in future sessions. The selected photo can be changed at any time. 
 
 

Learn More 
 
The Learn More section is a collection of hotlinks highlighting reference and training materials. 
 

 
 
1. View Help Options: bring up multiple links to various help options such as Quick Reference Guides, User Guides, 

Training, or Support. 
 

2. Install Fusion Web Collaboration for use on Outlook. 
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Quick Links 
 

 
 
 
Quick Links are quick, easy shortcuts to various often-used functions. NEXT: displays the next scheduled session. If one 
is not scheduled, nothing will display. View All Sessions and Recordings will jump to the My Sessions page. Add a New 
User opens the Add New User Wizard. 
 
View Green Meter Savings accesses the Green Meter Summary reporting page (see Reports). 
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Top Bar 
 

 
 
The Top Bar (located in the upper right hand corner) contains shortcut buttons that will allow you to quickly edit profile 
information, password, access help options, log out of the Communication Center, or update the time zone. 
 
 

Green Meter 
 
Helping to reduce our users' carbon footprint is a priority for us and the Green Meter is a large part of that. 
 

 
 
The Green Meter calculates (based on your location and certain defaults) the overall monetary, emissions, and fuel 
savings. 
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Frequently Used Sessions 
 

 
 
This section populates with quick links to several rooms that you use the most for your convenience. 
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Join Private Session 
 

 
 
If your company utilizes Private Sessions, they can easily be accessed here by entering the session ID in the box 
provided, then pressing Join. 
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MY SESSIONS 
 
Begin by clicking on My Sessions to view a list of your active sessions. 
 

 
 
 

 
 
This is a list of the active sessions in which you are the Owner, Leader, Assistant or Participant. 
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Notice the drop-down menu on the top left-hand corner of the pane. This will allow you to choose: 
 
• Active Sessions, currently available for use 

 
• Scheduled sessions that are coming up 

 
• Open sessions which have no set scheduled time 

 
• Recurring Sessions 

 
• Expired Sessions which have already passed, and 

 
• All sessions 
 
 

 
 
Also note the Search box in the upper right hand section of the screen. This will allow you to narrow the results if the site 
contains a large number of sessions. 
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Join Button 
 
Clicking on the Join button will immediately launch a session. 
 

 
 

 

Session Types 
 
Sessions come in several different varieties, indicated by the icons below and accompanying legend: 
 
• Classes: Designed for a more educational feel. 

 
• Support: Perfect for companies who require the ability to remotely connect to user 

computers, this allows a private, secure link. 
 

• Meetings: Designed for smaller, more collaborative presentations. 
 

• Webinar: Allows for a larger presentation and much higher control by the presenter. 
 

• Recording: A recording of a previous session, available here for easy viewing, editing, 
and other functions.  

 

Session Name 
 

 
 
By default, every user will have a meeting room created, usually named “John Smith’s Room” – for example. Each new 
session created will ask for a title, which can be edited later if needed. While in the My Sessions screen, each title will 
also act as a hyperlink. 
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Role 
 
This column indicates whether you are the Owner, Leader, an Assistant, or a Participant for a particular session. 
 
• Owner - The Owner is, by default, the user who first creates a session (this 

can be reset by selecting another user when creating or later editing the 
session by clicking the Replace button and then choosing a new). An 
Owner will be able to log in to and edit the session in Fusion Web 
Collaboration, and by default is also assigned as the leader (this can also 
easily be edited). 
 

• Leader - The Leader (also known as the Primary Instructor in a Class) is the 
person assigned to lead the session. A leader, by default, is set as the 
owner of the session, and will also be able to edit a session in Fusion Web 
Collaboration.  The Leader's main role is to be able to run all functions of a 
session. Unless the Owner or Leader turns off a function (i.e. launching a 
share), the Leader will be able to run all functions of the session. 
 

• Restricted Leader (Meeting Only) - A Restricted Leader has the ability to 
control a session, but not the option to request a share from anyone else in 
the session, ensuring also that the share will be halted when the floor is passed (this option is found under the Key 
Information section when editing a session, and when selected the Leader automatically becomes the Restricted 
Leader). 
 

• Assistant - An Assistant is someone assigned to assist the leader in their session. As such, an Assistant can initiate 
and run any function which a Leader would (provided these functions have not been turned off for Assistants in the 
session via the Communication Center). Generally speaking, Assistants may run a session with or without a Leader 
present. To add an attendee as an assistant, simply check the "Assistant" box next to their name on the attendee list 
when editing your session. The main distinction to note with an Assistant Role is whether the Assistant is a User on 
the company's site or a Guest on said site. If they are a User, they may do anything in session, but will not be able to 
edit the session. If a Guest, all the same rules apply, but in addition, they will not be able to log in to Fusion Web 
Collaboration. 
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Actions 
 
Several common session functions are contained here. 
 
More Info: Brings up the same dialog box as clicking on the session name, with the same options.  
 
Invitation: Allows you to send an invitation link through your email, the system, by copying the generic 
join link to your clipboard, Sending a Registration link, Copying a Registration link to your clipboard, or 
posting a Registration link to your integrated social media. 
 
Edit: Jumps to the Edit Session menus. 
 
Remove from Home Page: This will remove sessions belonging to other users you may not want on your home page. 
 
 

Public Sessions 
 
Public Sessions are a terrific way to allow guests to register themselves for sessions versus adding attendees 
individually. 
 

 
 
Your potential attendees will begin by navigating to your site. Since they do not have a login, they will only see several 
options, one of which is the Public Session link. Clicking on that link will bring them to a list of publicly available 
sessions. 
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To register for any of these public sessions, an attendee only needs to check the checkbox in the far left-hand column, 
then click the Register button below. The attendee will enter their information and registration will be approved (either 
manually or automatically, depending on how the leader has set the session). Once their registration is approved; the 
participant will receive their invite at the email address they entered. 
 
The above section discusses Site Public Sessions, which are readily accessible through a few clicks. In addition, for 
internal sessions where a user wants registration requests segregated for a specific group and not readily accessible to 
the general public, there is an option for Owner Public Sessions, which are only accessible through a specific URL, with a 
format of www.yoursite.com/public/join/username. 
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System Test 
 
This option is designed to see if a system is compatible with and prepared for a session. Part I (pictured) tests several 
basic pieces of functionality on a system. Part II connects to a test session which will give the participant the 
opportunity to try out most of the functions within the client and get used to the interface and controls. 
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MANAGE SESSIONS 
 
Most of the information in the following sections can also be accessed from the My Sessions page, however, to access 
the most options and functionality, access the Manage Sessions page. Begin by hovering over Manage on the top menu, 
then move down to Sessions. 
 

 
 
 
There are several subtle differences from the My Sessions page. First, the options on the drop-down menu above are a 
bit different, giving the user a choice to view only sessions that are Active, Inactive, and All sessions. Next, the Join 
button has been replaced by a checkbox. 
 

 
 
 
At the bottom of the session list, the buttons below, will allow the user to change the status of any session they have 
access to. Simply check the corresponding checkbox to the session you want to assign a new status to. 
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Creating a New Session 
 
For the most part, the interface used for creating a new session versus editing an existing one are exactly the same, just 
initiated by different icons. (Note: All session types above the first divider Meeting, Class, Webinar, Support Room, and 
Instant Session have the same creation/edit interface, with slightly different options. 
 

 
 
1. To create a new session, begin by hovering over the Add New Session button. A drop-down that looks much like the 

one above will appear. 
 

2. Choose the option you want and a new session screen will appear. To change the session later, click on the Edit 
icon. 
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3. The initial screen that comes up will look something like this: 
 

 
 

• Quick View – (pictured above) Quick View displays only the most important pieces of the session information, 
eliminating all advanced information. If you are not worried about overly customizing the session's appearance 
or functionality, and just want to get started quickly, this is the way to go. 
 

• Wizard View - This option will walk you through every option, screen-by-screen. Form View - A view which 
displays all options on one page. To learn more about the Wizard and the Form View please see the online help 
option. 
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4. Key Information - Enter in the necessary information in the Key Information Section (Note: asterisks denote a 
required field). 

 
• Title: Enter the Title for the session here. 

 
• Description: Optional field for any additional descriptive details. This description will appear on the Start Page 

in session 
 

• Leader: By default set to the Owner, the leader has full ability to run any functions in the session, as well as edit 
it. 
 

• Audio: Select the audio option for the session. The drop-down allows one of four settings: 
 

 
 

o Teleconference: Uses a teleconference bridge exclusively. 
 

o Internet Audio: Utilizes Voice Over Internet Protocol (VoIP) to allow communication. 
 

o Teleconference & Internet Audio: Participants may choose their method of Audio for the session. 
However, with this selection, Internet Audio is listen-only. 
 

o None: No integrated audio solution. All fields below for source information will disappear. 
 

• Source: If using either the Teleconference or Teleconference & Internet Audio option, this drop-down will 
appear. Choose one of the two choices listed. 

 
Now, on to the entry fields: 
 

 
 

• Primary Dial-In: The main dial-in conference number. 
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• Alternate Dial-In: A secondary number for guests who may not be able to use the primary line due to dialing 
restrictions, i.e. international dialers or those behind certain corporate systems. 
 

• Passcode: The required passcode for entry into the conference system. 
 

• Moderator Code: A special code given to all leaders and assistants to help identify them properly in the system. 
 

• Visual: Allows the choice of Attendee photographs only or Live video. Live video options include overall Size 
(measured in pixels) and Quality (determined by frames per second). 
 

 
 
Normal quality measurements are Low (2 frames per second), Medium (5 fps), and High (15fps), with a Max 
setting (30 fps) available as a premium option (see your Account Executive about this). You can also select to 
Automatically adjust video mode in the case of low bandwidth or camera restrictions. Bandwidth Required will 
be calculated on the fly, along with any warnings if the session's bandwidth needs are potentially high. 
 

• Controlled By: 
 

 
 

o Restricted Leader (Meeting only) has the ability to control a session, but not the option to request a 
share from anyone else in the session, ensuring also that the share will be halted when the floor is 
passed. When this option is selected, the leader automatically becomes a restricted leader. 
 

o Leader is the default, and ensures that no one but the leader may take the floor without being passed 
it first. 
 

o Anyone ensures all participants may be able to take control of the floor without needing the floor 
passed to them. 
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5. Enter in the Schedule information (date, start time, duration) for your session. 
 

 
 

• Open: Creates a session that is Always Available. 
 

• Single Occurrence: Schedules a session for an upcoming date. Checking Remove from Home Page When 
Expired ensures that it will no longer be visible on your home page after the session has occurred. 
 

• Recurring: Create a regularly scheduled session. 
 

6. Content: Upload any of the specified pieces of content into this interface, and it can be used and accessed in the 
session later. All pieces of content are automatically loaded into the Content Library for later use. To access content 
already in the Library, click the Libraries button, select, and click submit. 
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• Content can be Added, Edited, Removed, or re-ordered in the list. The figure illustrates several pieces of content 
already loaded. To load content, begin by choosing the appropriate file type from the drop-down menu in the 
upper left-hand corner. 
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• When adding a file, a dialog box, such as above, will appear. Certain options will differ according to the file type. 
 

i. Enter in a Title for the content. A description is optional. 
 

ii. Find the File on the local computer/server (compatible file extensions are listed below the entry 
box). For certain file types (i.e. Media Link); a URL address is also an option, or importing an XML 
file. 
 

iii. Under Availability, Allow this item to be available in Session will be checked by default. If you 
choose to make the piece of content available, you may also choose to have it auto-launch, 
and/or to hide it from your participants 
 

iv. Next, you will want to choose whether it is available from the Home Page (default is just the 
content page), available in Public Sessions, or from the invitational email. 
 

• File types are: 
 

o Media Link: Allows uploading of a media file, either from a local machine/server, or from a 
website. 
 

o File: Make a file (i.e. a PDF or Word document) available from the home page/Public 
Sessions page/E-mail link. 
 

o Recording: Incorporate another session Recording into your session. 
 

o Powerboard File: The Powerboard (.pdb) file is a format for converted PowerPoint 
Presentations or Whiteboards. This setting allows uploading already-converted files. 
 

o PowerPoint Presentation: Convert your PowerPoint Presentations into our universally-
viewable Powerboard, for easy access and use in session. 
 

o Polling: Create an interactive poll for use. 
 

o WebSync URL: WebSync allows launching of a website, utilizing the participants' browser 
within the session. Place a web address in this section for quick launching. 
 

7. Click Next. 
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8. Attendees: Add Attendees to the list. To place attendees into this list, begin by entering the First Name, Last Name, 
and E-mail Address into the field boxes at the top left of the pane, then click Add. If the participants have been a 
participant in one of the site's sessions in the past, click Select Attendees, then search and choose your participant 
from the list. 
 

 
 
To make a participant an assistant, check the Assistant box in the far right column. 
 

 
 
To send invitations immediately, click on the Save/Send button at the bottom of the page. 
 

9. Click Next. 
 

10. When you have finished entering in all of the necessary information for your session: Select Save to save all 
changes; Choose Save/Send to save changes and generate invitational emails from the system; or Press Cancel to 
erase all changes. 
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JOINING A SESSION 
 

Email Invitation 
 
Joining a session is very simple, just follow the steps below. 
 
1. From the e-mail Invitation, click on the link next to "Join this meeting." 

 

 
 

• Internet Explorer: When joining with Internet Explorer, click the yellow "Information Bar” and choose to 
install the ActiveX Plugin. Follow the prompts you receive & this will streamline joining future 
sessions. 
 

• Mozilla Firefox: Click on the Join button, then click Run. You will get a dialog box asking if you want to 
save a file called Session.exe. Click Save, and Session.exe will appear in your Downloads window. 
 

• Macintosh: When joining via the Mac platform, a separate dialog box will open asking if you want to 
save the .JNLP file or open it with Java Web Start. Click OK and the client file will download. If it asks 
for permission to run, click Allow. The client will automatically open. 
 

2. Fill out the form you are presented with your information and click Submit. 
 

3. If nothing happens automatically, click the "Manual Join" button to initiate the process. 
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4. If you receive any prompts, choose Run if possible (rather than saving the file) and answer yes to any other prompts 
you get. If your firewall or security program (i.e. Norton, McAfee, Black Ice) prompts you about, please choose to 
"Allow" the program to proceed so that you can join the session. 

Web Client 
 
Participants can join a session using the Web Client which runs in web browsers on Windows, Macs, iPads, and Android 
tablets. The Web Client includes these features: 
 
• Picture of the leader of the session 

 
• Attendees list 

 
• Public, private, and group chat 

 
• Start-up page which includes instructions to join the audio bridge, if available 

 
• View the presenter’s desktop, region, or application share, PowerPoint presentation, whiteboard, synchronized 

browser, and media 
 

• Interact with feedback, polls, tests and surveys 
 

• Audio during sessions where Internet Audio or listen-only audio is enabled (only supported on Mac and Windows 
and requires the Adobe Flash plugin) 

 
Leaders and assistants cannot use the Web Client. Also, a participant using the Web Client cannot be the Floor Holder; 
the participant must download the native client first using these steps: 
 
Before the floor can be passed, the leader and participant must: 
 
1. Leader notifies the participant that he/she must download the native client. The notification can take place over the 

phone or using public or private chat. 
 

2. Participant goes to the Start tab of the Web Client. 
 

3. Participant clicks on "Download". 
 

4. Participant downloads and installs the Windows or Mac client on the participant's computer. 
 

5. The leader or assistant is then allowed to select the participant has the floor holder. 
 
Note that a participant using the web client on an iPad or Android tablet cannot be the floor holder. 
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Also note that the Web Client must be enabled at the site level. Contact your administrator for activating the Web Client. 
 

 
 
Refer to the online help for additional ways in which to join. 
 
 

Audio 
 
Depending on the configuration the leader of the session has chosen, you may be prompted to use a teleconference, 
internet audio, or given the choice of the two. 
 
• Teleconference: If the screen displays an option to have the system dial you, enter your number and click Call. Your 

phone will ring shortly, and you will be prompted to join the call. If this option does not appear, dial the number 
displayed, enter the passcode when prompted, and then the unique identifier. You must enter the unique identifier in 
order to be properly identified in session. 
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• Internet Audio: Internet audio merely requires you to listen through your computer. For best results, we recommend 
using a USB headset. Attempting to use your computer speakers or a non-USB headset can result in multiple audio 
issues, including echo and complete failure. While it can be forced to work in some situations, this is not always 
reliable. It is for these reasons we only recommend using a USB headset. 
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USING A SESSION 
 
Once the Client has loaded, the interface will appear which will look something like the image below (If you are not a 
leader or assistant, you will not see all the options below and many of the menu options will be grayed out. Also note: 
Any options which are disabled in the Communication Center or due to hardware preferences/configuration will also be 
invisible). 
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Start Tab 
 
The Start Tab is the first tab visible upon initially joining a session. Typically it will contain details about the session, 
including the name and any Audio Details. Depending on the phone system utilized, you may utilize Internet Audio (VoIP), 
you may have the option to have the phone system dial you (pictured above), or you may need to manually dial a phone 
number and passcode (and in some cases a Unique Identifier). 
 

 
 
 

Basic Session Controls for Leaders and Assistants 
 
Throughout your session, you may want to adjust your communication settings. For example, maybe you want to get the 
attention of the leader, the volume of your voice is too loud, or you can’t hear others clearly. Session Controls gives you 
easy, one-click access to many tools to adjust and enhance your experience. 
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Sharing 
 

 
 
Sharing is a function which allows the leader to share an application, a portion of their screen, or even their entire 
desktop with everyone in a session, even when the other users do not have that application installed on their computer 
(note: only PC users can initiate an Application share). 
 
To initiate Sharing, begin by selecting the Share button from the Session Controls, or select Share from the sidebar or 
the Tools menu. Select the type of share you wish to use: 
 
• Desktop-Immediately share out your entire desktop to all attendees. Any window currently open underneath the 

application will display, including e-mail or instant messaging clients. 
 

• Application (PC Only)-Displays a list of current open applications on your computer. You can select one or more 
applications with the check box next to the name of the application, then click the Start button at the bottom to 
display these to attendees. 
 

• Region-Define a portion of your desktop to share. An outlined box will appear on your desktop. Click the Start button 
on top of the box, and any portion of your desktop contained within the outline will be shared. You can move or 
adjust the size of this box at any time to change the shared portion of your desktop. 

 

Sharing Toolbar 
 
Once a share is initiated, the sharing toolbar will be engaged at the top of your screen. Once the mouse cursor is moved 
away from the sharing toolbar, the toolbar will disappear. To access the sharing toolbar again, move the mouse cursor to 
the top of the screen. 
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Present 
 

 
 
This is a powerful presentation and white boarding tool that the session leader or floor holder can use to easily present 
PowerPoint presentations without any concerns about software versions or compatibility, instead saving them in the 
Powerboard (.pbd) file format. Present also contains markup tools that can be used to highlight or draw on the slide 
without changing the original material. This interface can also be launched outside of an session, and files can be saved 
for use outside of session. 
 
 

Annotation 
 
Available in either Present or Whiteboard, Annotation will allow leaders, assistants, and floor holders the opportunity to 
add markups, shapes, highlight, underline, or add text to the presentation. 
 
 

Whiteboard 
 

 
 
Utilizing the same interface as the Present tool, this interface simply brings up a virtual Whiteboard. 
 
 

WebSync 
 

 
 
WebSync is a synchronized web browser which allows the floor holder to take the entire group to any web-based content. 
Launch WebSync, enter the site address you wish to navigate to, and press Go. 
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Poll 
 

 
 
Poll is a communication tool that can be used to gather information from either a pre-loaded poll, or ask participants a 
question on-the-fly. To access it, either click the Poll button or proceed to Content and launch your poll from there. 
 
 

Media 
 

 
 
Media will launch either pre-loaded Media Files or a Live Stream. To begin, click the Media icon. If a clip is pre-loaded, 
select it and it will launch automatically. 
 

 
 
Media can be loaded on the fly by selecting New, then entering the URL and hitting Go. 
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Live Stream 
 
To access Live Stream, select Live Stream, choose the size and quality (frame rate) settings, and click OK (If the camera 
does not meet the resolution requirements for higher settings, Allow software up-scaling may be selected in order to 
compensate. 
 

 
 
 

Containers 
 
There are three containers displayed by default in a session: 
 
• Attendees: Keeps track of all attendees, their status, and role. 

 
• Feedback: Displays and tracks feedback polls as they are introduced. 

 
• Chat: Keeps track of Public and Private Chat, if enabled. 
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Each of the containers can be altered with the help of the icon shown below. Options include: 
 

 
 
• Dock: Control what sections of the screen containers are located. 

 
• Tab (Attendees only): Push attendee photos/video to the main window in Tab view. 
 

 
 
• Float: Allow a container to be popped out independently of the iLinc session window. Perfect for users who utilize 

multiple monitors. 
 
In addition, leaders and assistants have three other options: 
 
• Dock for All 

 
• Tab for All 

 
• Float for All 
 
To return to the default layout, select Session > Restore Layout. 
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Attendees 
 
As a participant in a session, there may be the ability to see the other participants that have joined. The Attendee panel 
provides a list of all attendees, including the Leader and any Assistants, as well as Participants of the session. It also has 
shortcut versions of status controls, controls the display options for attendees, audio, video, and who has control of the 
floor in the session. 
 
 

Feedback 
 
Feedback is a polling application that a session leader can use to solicit feedback from participants. When a question is 
asked, either verbally or in Chat, you may select an answer in the Feedback area. Use the feedback control shortcuts to 
control the way feedback results are displayed (i.e. type of graph), enter answers, etc. 
 
 

Chat 
 
Chat is an instant messaging tool for quick and easy text discussions. Depending on the setup of the session, you may 
be able to chat with the leader, assistant(s) or other participants in the session. Clicking the Private tab will provide you a 
list of those attendees with which you can directly chat. 
 
If enabled, private messages can be sent to the session leader(s) and assistant(s), or to designated participants by 
selecting the users name from the Private tab, and type a message into the new tab that opens in the chat area. 
 
Saving the Chat Transcript 
 
To save the chat, simply click the File menu item, click Save and then choose Chat. Using the computer navigation, 
select an appropriate place on either the local machine or any network drives that are accessible. 
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Basic Session Controls for Participants 
 

 
 
Throughout a session, you may want to adjust your communication settings. The My Controls section of the Tool Panel 
gives you easy, one-click access to the necessary tools to enhance your experience. 
 
 

My Status 
 

 
 
The My Status drop-down allows a number of feedback options (along with hotkey shortcuts listed). 
 
• Raise Hand-select again to lower. 

 
• Step Away-currently away from the session. 

 
• Applaud 

 
• Thumbs Up 

 
• Thumbs Down 
 

Audtio 
 

 
 
If you are using integrated audio, this will allow you to mute or unmute. 
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Video 
 

 
 
If you have a webcam connected and Video enabled for the session, you can turn your video on or off from here. 
 
 

Passing the Floor to a Web Client 
 
A leader or an assistant in a session may decide to give the floor to a participant using the Web Client. This is required, 
for example, to allow the participant to share his/her desktop. Before the floor can be passed, the leader and participant 
must: 
 
1. Leader notifies the participant that he/she must download the native client. The notification can take place over the 

phone or using public or private chat. 
 

2. Participant goes to the Start tab of the Web Client 
 

3. Participant clicks on "Download". 
 

4. Participant downloads and installs the Windows or Mac client on the participant's computer. 
 

5. The leader or assistant is then allowed to select the participant has the floor holder. 
 
Note that a participant using the web client on an iPad or Android tablet cannot be the floor holder. 
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Recording 
 
To begin recording, start by clicking the recording icon in the upper right-hand corner and selecting Record Session. 
 

 
 
The session will immediately begin recording. The record icon will display in the taskbar on a PC (lower right-hand corner 
near the time display), and in the upper bar on a Mac. Click on this icon, or the icon within the client, to pause or stop the 
recording. When stopping the recording, a dialog box will pop up, offering you the opportunity to save or discard the 
recording, and rename the recording file if so desired. 
 
 

End a Session 
 
To end the meeting, choose File > Exit or close the Session window by clicking the X button in the top right corner. If the 
Leader or Assistant end the meeting, they will have the option to Exit or Exit and Dismiss All participants For 
participants, clicking the X button will simply remove them from the meeting. 
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Depending on how the site default or session is configured, the Leader or Assistant can save the Attendee List and Chat 
Log. This setting can be found under Advanced Configuration. 
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Reports 
 
To access the reporting area: 
 
1. Click the Reports link on the Communications Center Home Page. The Report Links will appear: 

 

 
 
 
2. Click the Report Type, select the report to be run. The criteria change depending on the selected report. 
 
 
Activity Reports: 
 
Session Attendance & Registration: Use this report to view a detailed list of attendees who attended or registered for a 
session(s). 
 
Session Occurrence Summary: Use this report to view detailed usage data on every occurrence of sessions on your site. 
Site Activity Summary: Use this report to view a summary of sessions on the site. 
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Scheduled Sessions: Use this report to view information about sessions that are scheduled to occur within the date 
range selected. 
 
Current Activity Summary: Use this report to view a summary of all sessions that are currently in progress. 
 
Current Activity Detail: Use this report to view attendance information about specific sessions that are currently in 
progress. 
 
 
User Reports: 
 
User Profile Detail: Use this report to view user profile information including any custom user fields available on your 
site. 
 
User Session Detail: Use this report to view user profile information on users and the sessions they have joined, including 
scores and completion information for graded activities. 
 
User System Detail: Use this report to view detailed technical information on the computers used by people who have 
joined sessions. 
 
 
Green Meter Reports: 
 
Green Meter Summary: Use this report to view a site’s accumulated cost, travel, and emissions savings. 
 
Green Meter Detail: Use this report to view a detailed report on specific sessions cost, travel, and emissions savings. 
 
 
Storage Reports: 
 
Storage Summary: Use this report to view the total storage space utilized by the content files on the site. 
 
Storage Detail: Use this report to view information on content items, including the owner and dates of usage. 
 
Storage Owner Summary: Use this report to view specific user storage information. 
 
History Detail: Use this report to view the history of sessions, users, and content in a site, including creation, edit and 
usage. 
 
Scheduled Retirement: Use this report to view a list of items (sessions, content, and users) set to be retired for this site. 
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Personal Reports: 
 
My Progress: Use this report to view information on sessions you have joined and sessions for which you are registered. 
 
Your Room: Session Attendance: Use this report to view a detailed list of attendees who attended or registered for Your 
Room. 
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About Fusion 
Fusion delivers a comprehensive suite of innovative, yet proven cloud solutions to businesses of all sizes. Our advanced, 
high availability service platform enables the integration of leading edge solutions in the cloud, including cloud 
communications, cloud connectivity, cloud computing and additional cloud services such as storage and security. 
Fusion’s cloud solutions reduce our customers’ cost of ownership, and deliver new levels of security, flexibility, 
scalability and speed of deployment. 

 

Learn more at www.fusionconnect.com 
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